Ölçek (Scale) Nedir?
Fiziksel dünyada boyumuzu ölçmek için metreyi, ağırlığımızı ölçmek için teraziyi kullanırız. Ancak eğitim, psikoloji veya sosyal bilimler alanında "motivasyon", "kaygı", "iş tatmini", "dijital bağımlılık" gibi doğrudan gözümüzle göremediğimiz veya elimizle dokunamadığımız soyut kavramlar (gizil değişkenler) vardır. İşte ölçek, bu görünmez ve soyut yapıları somut sayılara, skorlara ve ölçülebilir verilere dönüştürmemizi sağlayan bilimsel ölçme araçlarıdır. Genellikle birbiriyle ilişkili bir dizi ifadeden (maddeden) ve bu ifadelere verilen yanıt seçeneklerinden (örneğin; "1-Kesinlikle Katılmıyorum ... 5-Kesinlikle Katılıyorum" şeklindeki Likert yapısı) oluşur. Bir ölçek sayesinde, bir öğrencinin matematiğe karşı tutumunun ne seviyede olduğunu istatistiksel olarak ifade edebiliriz.
Ölçek Geliştirme Nedir?
Ölçek geliştirme, ölçülmek istenen bu soyut kavramı doğru, hatasız ve tutarlı bir şekilde ölçecek aracı sıfırdan inşa etme sürecidir. Sadece alt alta sorular yazıp insanlara "Bunu doldurun" demek bir anket yapmaktır, ancak bilimsel bir ölçek geliştirmek değildir. Ölçek geliştirme, hem güçlü bir teorik altyapı gerektiren hem de katı matematiksel/istatistiksel kanıtlar (geçerlik ve güvenilirlik) sunulmasını zorunlu kılan sistematik bir yolculuktur.
Anket (Questionnaire/Survey) Nedir?
Anket; bireylerin belirli bir konudaki olgusal durumlarını, demografik özelliklerini (yaş, cinsiyet, eğitim, gelir durumu vb.), tercihlerini, eğilimlerini veya yüzeysel görüşlerini öğrenmek amacıyla hazırlanan, genellikle birbirinden bağımsız sorulardan oluşan veri toplama aracıdır. Pazar araştırmalarından siyasi seçim yoklamalarına, müşteri memnuniyetinden kurum içi durum tespitlerine kadar çok geniş bir yelpazede kullanılır. Sorular genellikle çoktan seçmeli, evet/hayır formatında, sıralama türünde veya kısa açık uçlu şekilde tasarlanır.
Anket ile Ölçek Arasındaki Kritik Fark Nedir?
Fiziksel olarak bir "soru kağıdı" veya "dijital form" gibi görünse de anket ve ölçeğin istatistiksel ve mantıksal arka planları tamamen farklıdır:
· Ankette sorular birbirinden bağımsızdır (Olguları ölçer): Bir anketteki soruların aralarında yüksek bir istatistiksel ilişki (korelasyon) olması beklenmez. Örneğin bir ankette; "Yaşınız kaç?", "Hangi marka bilgisayar kullanıyorsunuz?" ve "Günde kaç saat uyuyorsunuz?" soruları arka arkaya yer alabilir. Bu soruların cevaplarından elde edilen sayıları toplayıp tek bir skor elde edemezsiniz. Analizleri soru bazında yapılır (Örn: "Katılımcıların %60'ı A markasını tercih etmektedir" gibi).
· Ölçekte sorular bir bütündür (Soyut yapıları ölçer): Ölçek, doğrudan ölçülemeyen (gizil/soyut) tek bir psikolojik özelliği veya tutumu ölçmek için tasarlanır. Ölçekteki maddeler birbirlerine adeta zincirle bağlıdır ve aynı hedefe yöneliktir. Soruların tek başına bir anlamı yoktur; ancak hepsinin puanları toplandığında veya ortalaması alındığında anlamlı bir sonuç (örneğin "Tükenmişlik Skoru") ortaya çıkar. 
Somut Bir Örnekle Özetlemek Gerekirse: Eğitim ortamında öğrencilere, "Okula nasıl geliyorsunuz? (Servis/Yürüyerek/Otobüs)" ve "Günde kaç soru çözüyorsunuz?" diye soruyorsanız bir anket uyguluyorsunuz demektir. Ancak öğrencilerin "Matematik Dersine Yönelik Kaygılarını" ölçmek için birbirini destekleyen 15 maddelik (örn: Matematik sınavından bir gün önce uyuyamam, Tahtaya kalktığımda ellerim terler vb.) bir soru seti hazırlıyorsanız, bir ölçek kullanıyorsunuz demektir.
Anket ve Ölçek Arasındaki Temel Farklar Tablosu
	Karşılaştırma Kriteri
	Anket (Questionnaire / Survey)
	Ölçek (Scale)

	Neyi Ölçer?
	Gözlenebilir olguları, demografik bilgileri, tercihleri ve bağımsız durumları ölçer (Yaş, gelir, eğitim durumu, oy tercihi).
	Doğrudan gözlenemeyen, soyut (gizil) psikolojik, sosyolojik veya duyuşsal yapıları ölçer (kaygı, tutum, liderlik algısı).

	Soruların İlişkisi
	Sorular birbirinden bağımsızdır. Bir sorunun diğerini desteklemesi veya onunla ilişkili olması gerekmez.
	Sorular birbirine adeta zincirle bağlıdır. Tüm maddeler, aynı şemsiye kavramı (örneğin "tükenmişliği") ölçmek için bir araya gelir.

	Puanlama ve Skor
	Soruların cevapları toplanmaz. Her soru tek tek kendi içinde analiz edilir (Örn: "Katılımcıların %40'ı evet dedi").
	Soruların puanları toplanır veya ortalaması alınır. Bireyin o konudaki seviyesini gösteren tek bir "toplam skor" elde edilir.

	Geçerlik ve Güvenilirlik
	Temel düzeyde anlaşılırlık ve dil bilgisi (görünüş/kapsam geçerliği) yeterlidir. Ağır istatistiksel kanıt aranmaz.
	Katı istatistiksel kanıtlara (Açımlayıcı/Doğrulayıcı Faktör Analizi, Cronbach Alpha iç tutarlılık vb.) ihtiyaç duyar.

	Geliştirme Zorluğu
	Nispeten kolay ve hızlıdır. Sorular yazılır, uzmanlara gösterilir ve uygulanır.
	Zor, uzun ve maliyetlidir. Pilot uygulamalar, istatistiksel ayıklamalar ve teorik temellendirmeler gerektirir.



Sosyal bilimlerde ve eğitim araştırmalarında tutumları, inançları ve algıları ölçmek için tarihsel süreç içinde farklı yaklaşımlar geliştirilmiştir. İnsan davranışının ve düşüncesinin karmaşıklığı, araştırmacıları farklı matematiksel ve mantıksal temellere dayanan ölçek türleri tasarlamaya itmiştir.
Ölçek Türleri
1. Bogardus Sosyal Mesafe Ölçeği (Social Distance Scale)
1920'lerde Emory Bogardus tarafından geliştirilen bu ölçek, adından da anlaşılacağı üzere bireylerin belirli bir etnik, dini veya sosyal gruba karşı hissettikleri "sosyal mesafeyi" (veya önyargıyı) ölçmek için tasarlanmıştır.
· Mantığı: Ölçekteki maddeler, en uzak sosyal ilişkiden en yakın (en mahrem) sosyal ilişkiye doğru hiyerarşik bir sıra izler. Bir katılımcının bir gruba ne kadar "yakınlaşmaya" tahammül edebildiğini ölçer.
· Nasıl Çalışır? Katılımcıya "X grubundan birini..." şeklinde başlayan durumlar verilir ve hangilerini kabul edeceği sorulur.
1. Ülkemde sadece turist olarak bulunmasını kabul ederim.
2. Ülkemde vatandaş olmasını kabul ederim.
3. Benimle aynı mahallede yaşamasını kabul ederim.
4. Benimle aynı iş yerinde çalışmasını kabul ederim.
5. Benimle yakın arkadaş olmasını kabul ederim.
6. Ailemden biriyle evlenmesini (akraba olmayı) kabul ederim.
· Özelliği: Katılımcı örneğin 4. maddeye "Evet" diyorsa, mantıken 1, 2 ve 3. maddeleri de kabul etmiş sayılır. Puanlama, kişinin onayladığı en yakın (en yüksek) mesafe seviyesine göre yapılır.
2. Thurstone Ölçeği (Eşit Görünen Aralıklar Ölçeği)
Louis Thurstone tarafından 1928'de geliştirilen bu ölçek, tutumların ilk kez nicel olarak ölçülebileceğini kanıtlayan tarihi bir dönüm noktasıdır. Günümüzde geliştirilmesi çok zahmetli olduğu için nadir kullanılır.
· Mantığı: Bir konu hakkında yazılan düzinelerce ifade, uzmanlardan oluşan büyük bir jüriye (örneğin 50-100 kişi) verilir. Uzmanlar bu ifadeleri 1'den (en olumsuz) 11'e (en olumlu) kadar sıralar. Uzmanların üzerinde uzlaştığı maddelere bir "ağırlık (medyan) değeri" atanır.
· Nasıl Çalışır? Nihai anket katılımcıya verildiğinde, katılımcı sadece katıldığı ifadelere işaret koyar (Evet/Hayır şeklinde).
Madde A (Uzman Değeri: 8.5): Okul kuralları genel olarak faydalıdır.
Madde B (Uzman Değeri: 2.1): Okul kuralları öğrencileri baskılamak için vardır.
· Puanlama: Katılımcının skoru, işaretlediği maddelerin uzmanlar tarafından belirlenmiş ağırlık puanlarının ortalaması alınarak hesaplanır.
· Sınırlılığı: Uzman jürisi bulmak, onlara puanlama yaptırmak ve matematiksel ağırlıkları hesaplamak günümüz pratik araştırma dünyası için çok yorucu ve zaman alıcıdır.
3. Guttman Ölçeği (Birikimli Ölçek / Scalogram)
Louis Guttman tarafından 1944'te geliştirilen bu ölçek, tek boyutluluğu (unidimensionality) en katı şekilde savunan yaklaşımdır. Bogardus ölçeğinin mantığına çok benzer ancak sadece sosyal mesafe değil, her türlü tutum için kullanılabilir.
· Mantığı (Birikimlilik): Maddeler, en az zorlayıcı/kabul edilebilir olandan, en zor/radikal olana doğru sıralanır. Hiyerarşik bir yapı vardır. Katılımcının belirli bir şiddetteki maddeye katılması, ondan daha düşük şiddetteki tüm maddelere de katıldığı anlamına gelir.
· Nasıl Çalışır? Matematiğe yönelik tutumu ele alalım:
1. Sayı saymayı bilmek günlük hayatta işe yarar.
2. Temel matematik işlemleri (toplama, çıkarma) yapmak gereklidir.
3. Matematiksel problemleri çözmekten keyif alırım.
4. İleri düzey matematik (kalkülüs vb.) boş zaman hobilerim arasındadır.
· Özelliği: Eğer bir katılımcı 3. maddeye "Evet" diyorsa, mantıksal olarak 1. ve 2. maddelere de "Evet" demesi beklenir. Aksi bir durum (3'e evet deyip 1'e hayır demek) ölçümde hata (tutarsızlık) olduğunu gösterir. Geliştirmesi oldukça zordur çünkü bu kusursuz hiyerarşiyi yakalayan maddeler yazmak kolay değildir.
4. Likert Ölçeği (Toplamalı Derecelendirme Ölçeği)
Rensis Likert tarafından 1932'de geliştirilen ve günümüzde sosyal bilimlerde açık ara en çok kullanılan ölçek türüdür. Geliştirmesi, uygulaması ve analiz etmesi diğerlerine göre çok daha pratiktir.
· Mantığı: Katılımcıdan bir ifadeye (veya önermeye) katılma derecesini belirtmesi istenir. Her madde için genellikle 5'li veya 7'li bir dereceleme sunulur.
· Nasıl Çalışır? * İfade: Yapay zeka araçları eğitimde fırsat eşitliği sağlar.
Seçenekler: (1) Kesinlikle Katılmıyorum - (2) Katılmıyorum - (3) Kararsızım - (4) Katılıyorum - (5) Kesinlikle Katılıyorum.
· Özelliği (Toplamalılık): Guttman veya Bogardus'taki gibi maddeler arası hiyerarşi yoktur. Thurstone'daki gibi uzman ağırlıkları da yoktur. Her maddenin puanı eşittir. Katılımcının ölçekteki 20 soruya verdiği yanıtların puanları (1'den 5'e kadar) doğrudan toplanır veya ortalaması alınır. Toplam skor, kişinin tutumunun yönünü ve şiddetini belirler.
· Avantajı: Çok ince ayrımları (katılmıyorum ile kesinlikle katılmıyorum arasındaki farkı) yakalayabilir, istatistiksel analizlere (Faktör Analizi, ANOVA, t-testi) son derece uygundur.
Özetle Karşılaştırma:
· Bir grubun ne kadar dışlandığını ölçmek istiyorsanız Bogardus kullanırsınız.
· Soruların her birinin bilimsel ağırlığının farklı olmasını istiyorsanız Thurstone kullanırsınız (fakat epey yorulursunuz).
· "Bunu yapan, öncekileri de kesin yapmıştır" diyeceğiniz hiyerarşik bir yapı arıyorsanız Guttman kullanırsınız.
· İnsanların bir konudaki tutumlarının şiddetini kolay, güvenilir ve istatistiğe en uygun şekilde ölçmek istiyorsanız Likert kullanırsınız.
Ölçek Geliştirme Sürecinin Basamakları/Adımları
Ölçek geliştirme, gözle doğrudan görülemeyen soyut kavramları (tutum, kaygı, motivasyon, inanç vb.) sayısallaştırıp ölçülebilir hale getiren titiz bir "mühendislik" sürecidir. Bu süreç, sadece alt alta sorular yazmaktan ibaret değildir; birbiri ardına gelen katı istatistiksel ve mantıksal kurallara dayanır.
Konuyu daha iyi kavrayabilmek için tüm adımları "Siber Aylaklık (Derste, ders dışı amaçlı internet kullanımı)" algısını ölçecek yeni bir ölçek geliştirdiğimizi varsayarak, somut bir örnek üzerinden inceleyelim.

Adım 1: Kavramsal Çerçevenin Oluşturulması (Ne Ölçüyoruz?)
Ölçek geliştirmenin en kritik adımıdır. Ölçülecek yapının sınırları net çizilmezse, ilerideki tüm istatistikler hatalı çıkar.
· İşlem: İlgili literatür taranır, teoriler incelenir ve kavramın hangi alt boyutlardan oluştuğu belirlenir. Gerekirse hedef kitleyle mülakatlar yapılır.
· Örneğimiz: "Siber Aylaklık" nedir? Literatürü taradık ve gördük ki bu kavram tek tip değil. İki alt boyutu var:
1. Sosyal Aylaklık (Derste sosyal medyada gezinme, mesajlaşma)
2. Bilgi Amaçlı Aylaklık (Derste haber okuma, alışveriş sitelerine bakma). Hedefimizi ve boyutlarımızı böylece netleştirdik.
Adım 2: Madde Havuzunun Oluşturulması (Soruları Yazma)
Belirlenen teorik çerçeveye uygun olarak taslak maddeler (sorular) yazılır.
· İşlem: Nihai ölçekte olmasını istediğiniz madde sayısının en az 2-3 katı kadar soru üretmeniz gerekir. Çünkü bu maddelerin çoğu sonraki adımlarda elenecektir. Maddeler genellikle 5'li Likert (1-Kesinlikle Katılmıyorum ... 5-Kesinlikle Katılıyorum) formatında hazırlanır. Tek bir maddede iki farklı yargı bulunmamasına dikkat edilir.
· Örneğimiz: 20 soruluk bir ölçek hedefliyoruz. Bu yüzden 60 soruluk bir "taslak havuz" oluşturduk.
Doğru madde: "Dersteyken sık sık mesaj uygulamalarımı kontrol ederim."
Yanlış madde: "Dersteyken haber okurum ve arkadaşlarımla mesajlaşırım." (İki yargı var, katılımcı hangisine cevap vereceğini bilemez).
Adım 3: Uzman Görüşü ve Kapsam Geçerliği
Yazdığınız taslak soruların hedefteki kavramı gerçekten ölçüp ölçmediği ve dil bilgisi açısından doğru olup olmadığı uzmanlarca denetlenir.
· İşlem: Ölçek taslağı, alan uzmanlarına (örneğin 3 PDR uzmanı, 3 Ölçme-Değerlendirme uzmanı, 2 Türkçe uzmanı) gönderilir. Uzmanlar her maddeyi "Uygun", "Düzeltilmeli" veya "Uygun Değil" (Lawshe Tekniği) şeklinde puanlar. Puanı düşük olan veya uzmanların uyumsuz bulduğu maddeler havuzdan atılır.
· Örneğimiz: Bir uzman şu dönütü verdi: "15. maddedeki 'Twitter'da gezinirim' ifadesi çok spesifik. Twitter yerine 'sosyal medya platformlarında' derseniz daha kapsayıcı olur." Maddeyi düzelttik ve zayıf olan 10 maddeyi eledik. Elimizde 50 madde kaldı.
Adım 4: Pilot Uygulama (Bilişsel Görüşmeler)
Sorular devasa kitlelere gönderilmeden önce, anketin hedef kitlesinden küçük bir gruba (20-30 kişi) uygulanır.
· İşlem: Katılımcılardan sadece testi çözmeleri değil, "Soruyu okurken ne anladıklarını" sesli düşünmeleri istenir (Bilişsel Görüşme). Yönerge açık mı, test ne kadar sürüyor, kafa karıştıran kelime var mı diye bakılır.
· Örneğimiz: Anketi 25 öğrenciye çözdürdük. Öğrenciler "Ders esnasında cihazımla ilgilenirim" sorusunu okuyunca "Hocam, not almak için tablet kullanıyorum, bu da siber aylaklık mı sayılıyor?" diye sordular. Hemen maddeyi revize ettik: "Ders esnasında ders dışı amaçlarla cihazımla ilgilenirim."
Adım 5: Ana Uygulama (Veri Toplama)
İstatistiksel analizler için gerekli olan büyük verinin toplandığı aşamadır.
· İşlem: Kalan maddeler hedef kitleye uygulanır. Genel kural olarak madde sayısının en az 5 ila 10 katı kadar kişiye ulaşılması gerekir.
· Örneğimiz: Elimizde 50 madde var. 50 x 8 = 400 lise öğrencisine ulaşıp formları doldurttuk ve verileri SPSS gibi bir programa girdik.
Adım 6: Madde Analizi ve Açımlayıcı Faktör Analizi (AFA)
Ölçeğin omurgasının ortaya çıktığı istatistiksel ayıklama aşamasıdır. Kötü sorular çöpe gider, iyi soruların hangi alt boyutlarda kümelendiği keşfedilir.
· İşlem: * Madde-Toplam Korelasyonu: Testin geneliyle uyumsuz olan, farklı bir yöne giden maddeler silinir (Değer > 0.30 olmalıdır).
Faktör Analizi (AFA): Program, birbiriyle yüksek ilişki gösteren maddeleri matematiksel olarak gruplar. Bir madde hiçbir gruba girmiyorsa (yük değeri < 0.30) veya aynı anda iki farklı gruba aitmiş gibi görünüyorsa (binişiklik) o madde ölçekten atılır.
· Örneğimiz: SPSS'te analizi çalıştırdık. 50 maddenin 25'i matematiksel olarak bozuk çıktı (kimi kimseyle ilişkili değil, kimi her ikisine de girmiş). Onları sildik. Kalan 25 madde bilgisayar tarafından tam da Adım 1'de teoride öngördüğümüz gibi 2 ayrı gruba ayrıldı: "Sosyal" ve "Bilgi Amaçlı" siber aylaklık.
Adım 7: Doğrulayıcı Faktör Analizi (DFA)
AFA aşamasında "keşfedilen" ve elenen maddelerle son şeklini alan yapının, gerçekten çalışıp çalışmadığının ileri düzey yazılımlarla (AMOS, LISREL vb.) teyit edilmesidir.
· İşlem: Model bilgisayara çizilir. Verinin bu modele ne kadar "uyum" sağladığına bakılır (Uyum indeksleri: RMSEA, CFI, TLI, Ki-kare). Mümkünse bu adım için farklı bir örneklem grubundan (örneğin yeni bir 300 kişiden) veri toplanması daha bilimseldir.
· Örneğimiz: 2 alt boyutlu ve 25 maddelik yeni modelimizi AMOS programında test ettik. RMSEA değeri 0.05 çıktı (mükemmel uyum). Yani ölçeğimizin yapı geçerliği matematiksel olarak da kesinleşmiş oldu.

Adım 8: Güvenilirlik Analizleri
Geçerli olan bir ölçeğin, her ölçümde istikrarlı ve tutarlı sonuçlar verip vermeyeceğinin kanıtlanmasıdır.
· İşlem: * İç tutarlılık (Cronbach Alpha): Ölçekteki soruların birbirleriyle tutarlılığını gösterir (0.70 ve üzeri olması beklenir).
Test-Tekrar Test (Kararlılık): Aynı gruba ölçek 3-4 hafta arayla iki kez uygulanır. İki skor arasındaki korelasyonun yüksek olması istenir.
· Örneğimiz: 25 maddelik ölçeğimizin Cronbach Alpha katsayısı 0.88 çıktı (çok iyi). 3 hafta arayla aynı sınıfa iki kez uyguladık, öğrencilerin verdikleri cevaplar %90 oranında aynıydı.
Ölçek Maddesi Yazımında Dikkat edilecek İlkeler
Ölçek geliştirme sürecinde madde yazımı, ölçeğin kalitesini doğrudan belirleyen en kritik aşamalardan biridir. İyi yazılmamış maddeler, en güçlü istatistiksel analizleri bile anlamsız hâle getirebilir. 
1. Açık ve Anlaşılır İfade Kullanımı
Madde herkes tarafından aynı şekilde anlaşılmalıdır.
❌ Kötü örnek:
· “Mesleki etkileşimlerim bağlamında kolaboratif süreçlere iştirak ederim.” 
✔ İyi örnek:
· “Meslektaşlarımla birlikte çalışırım.” 
👉 Kural: Akademik değil, anlaşılır dil
2. Tek Yargı İçermeli (Çift Anlamlı Olmamalı)
Bir madde tek bir davranışı ölçmelidir.
❌ Kötü örnek (çift yargı):
· “Meslektaşlarımla plan yapar ve materyal paylaşırım.” 
✔ İyi örnek:
· “Meslektaşlarımla ders planı yaparım.” 
· “Meslektaşlarımla materyal paylaşırım.” 
👉 Buna double-barreled item denir ve mutlaka ayrılmalıdır.

3. Kısa ve Net Olmalı
Uzun maddeler anlaşılmayı zorlaştırır.
❌ Kötü örnek:
· “Okul ortamında karşılaştığım farklı pedagojik durumlarda meslektaşlarımla sürekli olarak etkileşim hâlinde bulunurum.” 
✔ İyi örnek:
· “Zor durumlarda meslektaşlarımdan destek alırım.” 
4. Olumsuz ve Ters Maddeler Dikkatli Kullanılmalı
Çok fazla ters madde katılımcıyı yanıltır.
❌ Kötü örnek:
· “Meslektaşlarımla iş birliği yapmam.” 
✔ Daha iyi kullanım:
· Ölçekte %20–30 oranında ters madde yeterlidir 
👉 Fazla ters madde → ölçme hatası
 5. Belirsiz İfadelerden Kaçınılmalı
“Bazen”, “genellikle”, “çoğu zaman” gibi ifadeler muğlaktır.
❌ Kötü örnek:
· “Genellikle meslektaşlarımla iletişim kurarım.” 
✔ İyi örnek:
· “Meslektaşlarımla iletişim kurarım.” 
6. Yönlendirici (Biaslı) İfade Kullanılmamalı
Katılımcıyı belirli bir cevaba yönlendirmemelidir.
❌ Kötü örnek:
· “İyi öğretmenler meslektaşlarıyla iş birliği yapar.” 
✔ İyi örnek:
· “Meslektaşlarımla iş birliği yaparım.” 



7. Sosyal Beğenirlik Etkisine Dikkat
Katılımcı “iyi görünmek” için cevap vermemeli.
❌ Kötü örnek:
· “Her zaman öğrencilerimin iyiliğini düşünürüm.” 
✔ Daha iyi:
· “Öğrencilerimin ihtiyaçlarını dikkate alırım.” 
8. Zaman ve Bağlam Net Olmalı
Madde hangi zaman dilimini kapsıyor belli olmalı.
❌ Kötü örnek:
· “Meslektaşlarımla iş birliği yaparım.” 
✔ İyi örnek:
· “Son bir ay içinde meslektaşlarımla iş birliği yaptım.” 
9. Teknik ve Uzmanlık Terimlerinden Kaçınılmalı
Tüm katılımcılar aynı eğitim düzeyinde olmayabilir.
❌ Kötü örnek:
· “Pedagojik formasyonum doğrultusunda kolektif etkileşim sağlarım.” 
✔ İyi örnek:
· “Meslektaşlarımla öğretimle ilgili fikir alışverişi yaparım.” 
10. Dengeli Madde Dağılımı Olmalı
· Olumlu ve olumsuz maddeler dengeli olmalı 
· Tüm boyutlar eşit temsil edilmeli 
📌 11. Likert Ölçeğine Uygun Yazım
Maddeler genellikle şu kalıpta olmalı:
👉 “... yaparım”
👉 “... hissederim”
👉 “... düşünürüm”
✔ Örnek:
· “Okul yöneticime güvenirim.” 
· “Meslektaşlarımla iş birliği yapmaktan memnuniyet duyarım.” 
12. Kültürel Uygunluk
Madde bağlama uygun olmalı.
❌ Kötü örnek (Türkiye için):
· “District supervisor ile düzenli iletişim kurarım.” 
✔ İyi örnek:
· “Okul yöneticimle düzenli iletişim kurarım.” 
Ölçek Geliştirme Sürecinde Lawshe Tekniği
Lawshe Tekniği, ölçek geliştirmede "Kapsam Geçerliği" (Content Validity) aşamasını kişisel yorumlardan ve belirsizlikten kurtarıp, tamamen nesnel ve istatistiksel bir temele oturtan oldukça pratik bir yöntemdir. C.H. Lawshe tarafından 1975 yılında geliştirilmiştir. Temel amacı; yazdığınız bir sorunun (maddenin) ölçekte gerçekten yer alıp almaması gerektiğine, uzmanların oylarını matematiksel bir formüle dökerek ve "şans faktörünü" eleyerek karar vermektir.
Bu tekniği adım adım ve somut bir örnek üzerinden inceleyelim:
1. Uzman Değerlendirme Ölçeğinin Hazırlanması
Taslak maddelerinizi (soru havuzunuzu) hazırladıktan sonra, ilgili alan uzmanlarına (genellikle 5 ile 40 kişi arası) bir değerlendirme formu gönderirsiniz. Lawshe tekniği, uzmanların her bir maddeyi şu üç seçenekten biriyle oylamasını ister:
· Gerekli: Bu madde, ölçmek istediğimiz yapı için kesinlikle şarttır.
· Yararlı ama gerekli değil: Bu madde olsa iyi olur, yapıyı destekler ama olmazsa da ölçek bir şey kaybetmez.
· Gerekli değil: Bu madde ölçmek istediğimiz hedefle alakasızdır, havuzdan çıkarılmalıdır.
2. Kapsam Geçerlik Oranının (KGO) Hesaplanması
Uzmanlardan formlar geri döndüğünde, her bir madde için ayrı ayrı Kapsam Geçerlik Oranı (KGO) hesaplanır. Formül oldukça basittir:
[image: ]
Aşağıdaki formülle de kapsam geçerlik oranı hesaplanabilir:
[image: ]
Bu formülden çıkacak sonuç her zaman -1 ile +1 arasında bir değer alır. Eğer uzmanların yarısından fazlası bir maddeye "Gerekli" derse sonuç pozitif çıkar; yarısından azı derse negatif çıkar. Tam yarısı derse KGO sıfır (0) olur.
3. Somut Bir Örnekle Hesaplama
Diyelim ki eğitim yöneticileri için bir "Dijital Liderlik Ölçeği" geliştiriyorsunuz ve formu 10 alan uzmanına gönderdiniz.
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4. Karar Aşaması: Hangi Maddeler Ölçekte Kalacak?
Bulduğumuz bu KGO değerleri tek başına yetmez. Uzmanların bu cevapları tamamen rastgele (şans eseri) işaretlemiş olma ihtimalini ortadan kaldırmak için, Lawshe bir Kritik Değerler Tablosu yayınlamıştır.

Kapsam Geçerlik Oranı (KGO) İçin Minimum Kritik Değerler Tablosu
	Uzman Sayısı
	Minimum Kritik Değer

	5
	1.000

	6
	1.000

	7
	1.000

	8
	0.750

	9
	0.778

	10
	0.800

	11
	0.636

	12
	0.667

	13
	0.538

	14
	0.571

	15
	0.600

	20
	0.500

	25
	0.440

	30
	0.333

	35
	0.314

	40
	0.300



Örneğimize dönersek:
Bizim 10 uzmanımız vardı, demek ki referans alacağımız alt sınır 0.80 olmalıdır.
· Madde 1 (KGO = 0.80): 0.80 değeri, 0.80 sınırından eşit veya büyük olması nedeniyle bu maddenin kapsam geçerliği kanıtlanmıştır. Ölçekte kalır.
· Madde 2 (KGO = -0.60): Sınırın çok çok altında kalmıştır. Bu madde kesinlikle ölçekten atılır.
(Eğer hesapladığınız değer kritik eşikle birebir aynı çıkarsa, maddeyi düzeltip/revize edip kullanma inisiyatifi araştırmacıya bırakılır.)
5. Ölçeğin Bütünü İçin Kapsam Geçerlik İndeksi (KGİ)
Kötü maddeleri eledikten sonra, elinizde kalan geçerli maddelerin (örneğin kalan 30 maddenin) KGO'larının aritmetik ortalaması alınır. Bulunan bu değere Kapsam Geçerlik İndeksi (KGİ - CVI) denir. Tüm testin KGİ değeri de tablodaki sınır değerden (10 uzman için 0.62'den) yüksekse, tüm ölçeğinizin yapı geçerliği öncesi "uzman onayından (kapsam geçerliğinden) başarıyla geçtiğini" makalenizde raporlayabilirsiniz.
Daha önce bahsettiğimiz Lawshe tekniği, matematiksel formülü ve yayınladığı tablo gereği minimum 5 uzman ile çalışmaya başlar. Elinizde 3 veya 4 uzman görüşü varsa, Lawshe tablosunda bunun bir karşılığı olmadığı için Kapsam Geçerlik Oranı (KGO) hesaplamanız istatistiksel olarak anlamsızlaşır. Böyle bir durumda Davis Tekniğini (1992) kullanabilirisiniz.
Alternatif Yöntem: Davis Tekniği (1992)
Eğer uzman sayınız 5'in altındaysa, Lawshe yerine literatürde yine çok kabul gören Davis Tekniği'ni kullanabilirsiniz. Davis tekniği, az sayıdaki uzmanla da Kapsam Geçerlik İndeksi (KGİ) hesaplamanıza olanak tanır.
· Nasıl Çalışır? Uzmanlara 3 seçenekli Lawshe formu yerine 4 seçenekli bir form gönderirsiniz:
1. Uygun değil
2. Maddenin yapısı ciddi olarak gözden geçirilmeli
3. Uygun ancak ufak değişiklikler gerekli
4. Oldukça uygun
· Hesaplama: Bir madde için 3. ve 4. seçeneği (yani "uygun" diyenleri) işaretleyen uzman sayısını, toplam uzman sayısına bölersiniz.
· Örnek: 4 uzmanınız var. Bir maddeye 3 uzman "Oldukça uygun" (4) veya "Ufak değişiklik gerekli" (3) dedi. Bir uzman ise "Uygun değil" (1) dedi.
1. Hesap: 3 / 4 = 0.75
· Kritik Eşik: Davis tekniğinde genel kabul gören sınır 0.80'dir. Eğer endeksiniz 0.80'in altındaysa madde revize edilir veya atılır. (Eğer 3 uzmanınız varsa ve 1'i bile uygun demezse oran 0.66'da kalır, maddeyi mecburen elersiniz).
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Kendall’ın Uyum Katsayısı
Önceki aşamalarda konuştuğumuz Lawshe veya Davis teknikleri, uzmanların bir madde için "Bu madde gereklidir / uygun değildir" şeklinde kategorik kararlar vermesine dayanıyordu. Ancak bazen uzmanlardan maddeleri sadece onaylamalarını değil; onları derecelendirmelerini (örneğin 1'den 10'a kadar puanlamalarını) veya sıralamalarını (en önemliden en önemsize doğru) isteriz. 
Kendall’ın Uyum Katsayısı (Kendall's Coefficient of Concordance - W), 3 veya daha fazla uzmanın, bir grup maddeye verdikleri puanlar veya sıralamalar arasında istatistiksel olarak anlamlı bir uzlaşı (fikir birliği) olup olmadığını test eden parametrik olmayan bir istatistiksel yöntemdir.
Bu yöntemi teorik yapısı ve somut bir örnekle adım adım inceleyelim:
Temel Mantığı Nedir?
Kendall'ın W testi, özünde şu soruyu yanıtlar: "Bu uzmanlar puanlama yaparken aynı zihinsel pencereden mi bakıyorlar, yoksa her biri birbirinden tamamen bağımsız, rastgele puanlar mı dağıtıyor?"
· İstatistik programı (örn. SPSS), her uzmanın maddelere verdiği puanları önce kendi içinde sıraya dizer (en düşük puandan en yüksek puana doğru rank atar).
· Daha sonra her bir madde için uzmanların verdiği sıra değerlerini toplar.
· Eğer uzmanlar mükemmel uyum içindeyse: Birinci madde herkes tarafından en yüksek puanı almış, sonuncu madde herkes tarafından en düşük puanı almış demektir. Bu durumda maddelerin toplam puanları arasında devasa uçurumlar oluşur (Varyans yüksektir).
· Eğer uzmanlar uyumsuzsa: Biri birinci maddeye 10 puan, diğeri 2 puan, bir diğeri 5 puan vermiştir. Maddelerin toplam puanları birbirine çok yakın çıkar (Varyans düşüktür).
Örnek
Diyelim ki bir "Öğretmen Liderliği Ölçeği" geliştiriyorsunuz ve taslakta 4 maddeniz var. Formu 5 uzmana gönderdiniz ve onlardan bu 4 maddeyi 1'den (en zayıf) 4'e (en güçlü) kadar önem derecesine göre sıralamalarını istediniz. Gelen cevaplar SPSS’e işlenmiş olsun. Buna göre SPSS’te 5 uzmanın verdiği yanıtlar analiz edildiğinde ölçek maddeleri ile uzman görüşleri arasında istatistiksel olarak fark olmadığı (Kendall’s W= 0,43; p=0,645>0,05) tespit edilmiştir. Başka bir deyişle p > 0.05 olduğundan uzmanlar arasında anlamlı bir uyum bulunamamıştır; maddeler gözden geçirilmelidir. p<0.05 olsaydı görüş birliği vardır sonucuna ulaşılırdı (istenen durum).
Faktör Analizi 
Faktör analizi, birbiriyle ilişkili çok sayıdaki gözlenebilir değişkeni (örneğin bir anketteki onlarca soruyu) bir araya getirerek, daha az sayıda, anlamlı ve birbirinden bağımsız gizil (gözlenemeyen) değişkenler (faktörler veya alt boyutlar) bulmayı amaçlayan çok değişkenli bir istatistiksel yöntemdir.
Özetle; karmaşık ve büyük veri yığınlarını, veri kaybını en aza indirerek daha basit, anlaşılır ve özet bir yapıya dönüştürme işlemidir.
Faktör Analizi Neden Önemlidir?
Sosyal bilimler, eğitim ve psikoloji gibi alanlarda faktör analizinin hayati öneme sahip olmasının temel nedenleri şunlardır:
· Boyut İndirgeme (Veri Özeti): 50 soruluk bir anketi tek tek analiz etmek yerine, bu soruların aslında 2 temel konuyu (örneğin: içsel motivasyon, dışsal motivasyon) ölçtüğünü göstererek veriyi yönetilebilir hale getirir.
· Yapı Geçerliği (Construct Validity): Geliştirilen bir ölçeğin, gerçekten ölçmeyi hedeflediği teorik yapıyı ölçüp ölçmediğini kanıtlar. Bilimsel makalelerde bir ölçeğin kullanılabilirliğinin en büyük kanıtıdır.
· Teori Geliştirme: Soyut kavramların (zeka, liderlik, iş tatmini, tükenmişlik vb.) alt bileşenlerinin neler olduğunu ortaya çıkararak bilimsel teorilerin inşasına katkı sağlar.
· Çoklu Doğrusal Bağlantıyı (Multicollinearity) Önleme: Regresyon gibi ileri düzey analizlerden önce, birbirine çok benzeyen değişkenleri tek bir faktör altında birleştirerek modelin istatistiksel olarak çökmesini engeller.
Faktör Analizi Kaça Ayrılır?
Faktör analizi, araştırmacının amacına ve elindeki teorik bilgi düzeyine göre temel olarak ikiye ayrılır:
	Özellik
	Açımlayıcı Faktör Analizi (AFA)
	Doğrulayıcı Faktör Analizi (DFA)

	İngilizce Karşılığı
	Exploratory Factor Analysis (EFA)
	Confirmatory Factor Analysis (CFA)

	Temel Amaç
	Keşfetmek: Verinin içinde hangi boyutların gizli olduğunu bulmak.
	Test Etmek: Önceden belirlenmiş teorik bir yapının veriye uyup uymadığını doğrulamak.

	Teorik Altyapı
	Araştırmacının değişkenlerin nasıl kümeleneceğine dair kesin bir fikri veya güçlü bir teorisi yoktur.
	Araştırmacının hangi sorunun hangi faktörde yer aldığına dair net bir teorik modeli vardır.

	Kullanım Yeri
	Sıfırdan yeni bir ölçek geliştirilirken kullanılır.
	Başka bir kültürde geliştirilmiş ölçek uyarlanırken veya AFA ile bulunan yapı test edilirken kullanılır.

	Değişken İlişkileri
	Analizde her soru (madde), bütün faktörlerle ilişkiye girebilir; bilgisayar serbestçe yükleri hesaplar.
	Her soru sadece ait olduğu teorik faktörle ilişkilendirilir, diğerlerine çapraz yük vermesine izin verilmez.



Faktör Analizinin Temel Varsayımları
Faktör analizine (özellikle de Açımlayıcı Faktör Analizine) başlamadan önce veri setinin bu analize uygun olup olmadığını test etmek zorundayız. Varsayımları karşılamayan bir veri setiyle yapılan faktör analizi, bilgisayar tarafından hesaplanır ancak çıkan sonuçlar bilimsel olarak anlamsız ve yanıltıcı olur. Faktör analizinin temel varsayımları şunlardır:
1. Veri Tipi (Ölçüm Düzeyi) Varsayımı
Faktör analizine dâhil edilecek değişkenlerin (maddelerin) aralık (interval) veya oran (ratio) ölçeğinde, yani sürekli veri olması gerekir.
· Sosyal Bilimler Pratiği: Cinsiyet, medeni durum gibi kategorik (nominal) değişkenlerle faktör analizi yapılmaz. Sosyal bilimlerde yaygın olarak kullanılan Likert tipi ölçekler (Kesinlikle Katılmıyorum 1 ... Kesinlikle Katılıyorum 5) aralık ölçeği olarak kabul edilir ve faktör analizine dâhil edilir.
2. Örneklem Büyüklüğü (Sample Size)
Faktör analizi, büyük örneklemlere ihtiyaç duyan bir analizdir. Örneklem küçükse, değişkenler arasındaki korelasyon katsayıları güvenilmez hale gelir. Literatürde iki temel kural takip edilir:
· N Kuralı: Genel kabul gören görüşe göre örneklem sayısı en az 200-300 kişi olmalıdır.
· Katılımcı/Madde Oranı Kuralı: Madde (soru) sayısının en az 5 katı, ideal olarak ise 10 katı katılımcıya ulaşılmalıdır. (Örneğin; 30 maddelik bir ölçek taslağı için en az 150, ideal olarak 300 kişiden veri toplanmalıdır).
3. Verinin Faktörleşebilirliği (Değişkenler Arası İlişki)
Faktör analizinin kalbi korelasyondur. Soruların bir alt boyut (faktör) oluşturabilmesi için birbirleriyle orta düzeyde ilişkili olmaları gerekir. Birbiriyle hiç alakası olmayan sorulardan faktör çıkmaz. Bu durumu kanıtlamak için iki test kullanılır:
· KMO (Kaiser-Meyer-Olkin) Örneklem Yeterliliği Ölçütü: Veri setindeki maddelerin faktör analizi için yeterli ilişkiye sahip olup olmadığını gösterir. 0 ile 1 arasında değer alır. Faktör analizi yapabilmek için KMO > 0.60 (bazı kaynaklara göre > 0.70) olmalıdır. Değer 1'e yaklaştıkça verinin uygunluğu mükemmelleşir.
· Bartlett Küresellik Testi (Bartlett's Test of Sphericity): Değişkenlerin birbiriyle ilişkisiz olduğunu (korelasyon matrisinin birim matris olduğunu) iddia eden yokluk hipotezini test eder. Bu testin anlamlı çıkması (p < 0.05) istenir. Anlamlıysa, "Maddeler arasında yeterli korelasyon var, analize devam edilebilir" demektir.
4. Normallik (Normality)
Faktör analizinin temelini oluşturan korelasyon hesaplamaları normal dağılım varsayımına dayanır.
· Tek Değişkenli Normallik: Her bir maddenin çarpıklık (skewness) ve basıklık (kurtosis) değerlerinin kabul edilebilir sınırlar içinde (genellikle ±1.5 veya ±2 arası) olması beklenir.
· Çok Değişkenli Normallik (Özellikle DFA için): Doğrulayıcı Faktör Analizi'nde (Maximum Likelihood yöntemi kullanıldığında) çok değişkenli normallik kritik bir varsayımdır. Normallik ihlal edilirse ki-kare (x2) değeri gereğinden yüksek çıkar ve model uyumu bozulur.
5. Doğrusallık (Linearity)
Faktör analizi, maddeler arasındaki ilişkinin doğrusal (lineer) olduğu varsayımına dayanır. Eğer iki değişken (madde) arasında eğrisel (U şeklinde vb.) bir ilişki varsa, Pearson korelasyon katsayısı bu ilişkiyi yakalayamaz ve faktör analizi zayıf sonuçlar üretir.
6. Çoklu Doğrusal Bağlantı (Multicollinearity) ve Tekillik (Singularity) Olmaması
Maddelerin birbiriyle ilişkili olmasını isteriz (r>0.30) ancak birbirinin tamamen aynısı olmasını istemeyiz. Eğer iki soru arasındaki korelasyon çok yüksekse (örneğin r> 0.80 veya 0.90), bu iki soru aslında tıpatıp aynı şeyi ölçüyor demektir. Bu duruma “çoklu doğrusal bağlantı” denir ve istatistiksel hesaplamaları (matrisin tersinin alınmasını) bozarak faktör çözümünü çökertir. Böyle bir durumda birbirine tıpatıp benzeyen iki sorudan birinin analizden çıkarılması gerekir.
7. Uç Değerler (Outliers) ve Kayıp Verilerin (Missing Data) Olmaması
· Uç Değerler: Faktör analizi ortalama ve standart sapma üzerinden korelasyon hesapladığı için, aşırı uç değerlere (outliers) karşı son derece hassastır. Analiz öncesi            Z-skorları veya Mahalanobis Uzaklığı gibi yöntemlerle uç değerler veri setinden temizlenmelidir.
· Kayıp Veri: Bir satırda eksik veri varsa analize dâhil edilmez. Kayıp veri oranı çok düşükse (%5'ten az) seri ortalaması atama vb. yöntemler kullanılabilir, aksi halde eksik veri içeren katılımcılar listeden silinmelidir (listwise deletion).
SPSS’te AFA Aşamaları ve Uygulamaları 
Aşama 1: Analizi Başlatma ve Ayarlar (SPSS Menü Adımları)
Öncelikle SPSS'te üst menüden şu yolu izliyoruz: Analyze -> Dimension Reduction -> Factor...
Açılan pencerede sol taraftaki ölçek maddelerini (soruları) sağ taraftaki "Variables" kutusuna atıyoruz. Sonra sırasıyla yandaki butonlara tıklayarak şu ayarları yapıyoruz:
1. Descriptives (Tanımlayıcılar) Butonu:
· Açılan pencerede alt kısımdaki KMO and Bartlett's test of sphericity kutucuğunu kesinlikle işaretliyoruz. (Varsayımları test etmek için).
· Continue diyoruz.
2. Extraction (Çıkarma/Faktörleştirme) Butonu:
· Method: Varsayılan olarak "Principal Components (PCA)" gelir. PCA olarak bırakılır.
· Display: Scree plot (Yamaç-birikinti grafiği) kutucuğunu işaretliyoruz.
· Extract: Varsayılan olan "Based on Eigenvalue greater than 1" (Özdeğeri 1'den büyük olanlar) olarak kalmalıdır.
· Continue diyoruz.

3. Rotation (Eksen Döndürme) Butonu:
· Eğer faktörlerin (alt boyutların) birbiriyle teorik olarak ilişkili olduğunu düşünüyorsanız (ki eğitim ve psikolojide genelde öyledir), Promax veya Direct Oblimin (Eğik döndürme) seçmelisiniz.
· Eğer faktörlerin kesinlikle birbiriyle ilişkisiz olduğunu savunuyorsanız Varimax (Dik döndürme) seçmelisiniz.
· Continue diyoruz.
4. Options (Seçenekler) Butonu: 
Sorted by size kutucuğunu işaretliyoruz (Faktör yüklerini büyükten küçüğe sıralar).
· Suppress small coefficients kutucuğunu işaretliyoruz. Altındaki "Absolute value below" değerini 0.30 (veya daha katı olmak isterseniz 0.40) yapıyoruz. Böylece düşük değerli yükler tabloda boş görünür, kafa karıştırmaz.
· Continue ve ardından OK diyerek analizi çalıştırıyoruz.
Aşama 2: Çıktıların (Output) Okunması ve Kritik Eşik Değerler
Analiz bittiğinde SPSS bize birçok tablo verir. Sırasıyla şu tablolara ve eşik değerlere bakarız:
1. KMO and Bartlett's Test Tablosu
Verimizin AFA'ya uygunluğunu gösteren ilk önemli ölçüttür.
· KMO Measure of Sampling Adequacy: Minimum 0.60 olmalıdır. (0.70 iyi, 0.80 çok iyi, 0.90 mükemmel kabul edilir). 0.60'ın altındaysa veri seti faktör analizi için yetersizdir.
· Bartlett's Test of Sphericity (Sig. / p değeri): Kesinlikle anlamlı yani p < 0.05 olmalıdır. (Genelde .000 çıkar). Anlamlı çıkması, maddeler arasında faktör oluşturacak kadar korelasyon olduğunu kanıtlar.
2. Communalities (Ortak Varyanslar) Tablosu
Her bir maddenin analize ne kadar katkı sağladığını gösterir. "Extraction" sütununa bakılır.
· Kritik Eşik: Değeri 0.20 veya 0.30'un altında olan maddeler, diğer maddelerle yeterli varyansı paylaşamıyordur. Bu maddeler sorunludur ve ilerleyen aşamalarda silinmeye adaydır.
3. Total Variance Explained (Açıklanan Toplam Varyans) Tablosu
Ölçeğin toplamda kaç alt boyut (faktör) ürettiğini ve bu yapının gerçeği ne kadar yansıttığını gösterir.
· Özdeğer (Eigenvalue) Kuralı: "Initial Eigenvalues" sütununda değeri 1.00'den büyük olan satır sayısı, çıkan faktör sayısını verir.
· Açıklanan Varyans Oranı: "Cumulative %" sütununda, son faktörün hizasına bakılır. Sosyal bilimlerde yapının toplam varyansın en az %50 ile %60'ını açıklaması beklenir (Çok faktörlü ölçeklerde bu oran %40'lara kadar esneyebilir). Bir ölçeğin veya testin "tek boyutlu" (yani tek bir yapıyı ölçen) olarak kabul edilebilmesi için de açıklanan varyansın en az %30 ile %40 arasında olması beklenir.
4. Scree Plot (Yamaç-Birikinti Grafiği)
Özdeğer tablosunun görselleştirilmiş halidir.
· Nasıl Okunur?: Dağdan aşağı inen bir yamaç gibi düşünün. Eğimin sert düştüğü noktalara bakılır. Grafiğin yataylaşmaya başladığı (kırılma noktası yaratan) nokta bulunur. Kırılma noktasının üzerindeki nokta sayısı, gerçek faktör sayısını verir. Çoğu zaman Özdeğer tablosundaki faktör sayısını doğrulamak için kullanılır.
5. Pattern Matrix / Rotated Component Matrix (Faktör Yükleri Tablosu)
Analizin en kritik tablosudur. Maddelerin hangi faktörlere ne kadar güçlü tutunduğunu gösterir. (Promax yaptıysanız Pattern Matrix, Varimax yaptıysanız Rotated Component Matrix tablosuna bakarsınız).
Burada Madde Ayıklama Kriterlerine (Kritik Eşiklere) Dikkat Edilir:
· Yük Düşüklüğü Kuralı: Bir maddenin faktör yükü en az 0.30 (bazı kaynaklara göre 0.40) olmalıdır. Hiçbir faktörde bu değeri göremeyen madde tablodan silinmelidir.
· Binişiklik (Cross-Loading) Kuralı: Bir madde aynı anda iki veya daha fazla faktöre yük veriyorsa (örneğin 1. faktörde 0.65, 2. faktörde 0.55 yükü varsa) bu madde binişiktir. İki yük arasındaki fark 0.10'dan (bazı kaynaklara göre 0.15 veya 0.20'den) küçükse, bu madde hangi faktöre ait olduğuna karar verememiştir ve kesinlikle silinmelidir.
Aşama 3: İterasyon (Madde Silme Süreci)
AFA tek tuşla biten bir işlem değildir. Pattern Matrix tablosunda binişik olan veya düşük yük veren sorunlu maddeler tespit edilir.
· Çok Önemli Kural: Sorunlu maddeler aynı anda değil, tek tek silinir. Önce en kötü durumdaki (binişiklik farkı en az olan veya yükü en düşük olan) madde veri setinden (Analyze -> Factor menüsündeki Variables kutusundan) dışarı atılır ve analiz baştan çalıştırılır. Çünkü bir maddenin çıkması tüm matrisi değiştirecektir.
· Hiçbir binişik veya düşük yüklü madde kalmayana kadar bu "sil ve tekrar çalıştır" işlemi devam eder. Tertemiz bir tablo (Basit Yapı / Simple Structure) elde edildiğinde AFA sona erer.
Doğrulayıcı Faktör Analizi (DFA) Nedir?
Doğrulayıcı Faktör Analizi (Confirmatory Factor Analysis – CFA/DFA), araştırmacının daha önceden belirlediği teorik bir yapının (ölçüm modelinin), toplanan gerçek verilerle ne derece uyumlu olduğunu test eden ileri düzey bir istatistiksel analizdir. AFA'da bilgisayar (SPSS) maddeleri kafasına göre faktörlere dağıtırken; DFA'da (AMOS) kontrol tamamen araştırmacıdadır. Araştırmacı bilgisayara önceden "Hangi sorunun hangi faktöre ait olduğunu" çizer ve programdan sadece bu çizilen modelin veriye ne kadar oturduğunu (uyum iyiliğini) hesaplamasını ister.
DFA Neden Önemlidir?
· AFA'nın Sağlamasıdır: AFA ile yeni geliştirilen bir ölçeğin yapısının, farklı bir örneklem üzerinde çalışıp çalışmadığını matematiksel olarak kanıtlar.
· Ölçek Uyarlama İçin Zorunludur: Yabancı dildeki (örneğin İngilizce) bir ölçeği Türkçeye uyarlıyorsanız AFA yapılmaz, doğrudan DFA yapılır. Çünkü orijinal ölçeğin teorik yapısı zaten bellidir; amaç bu yapının Türk kültüründe de "doğrulanıp doğrulanmadığını" görmektir.
· Yapı Geçerliğinin En Güçlü Kanıtıdır: Yakınsak (Convergent) ve Iraksak (Discriminant) geçerlik gibi makalelerde istenen ileri düzey metrikler (AVE ve CR değerleri) sadece DFA sonuçları üzerinden hesaplanabilir.
· YEM'in (Yapısal Eşitlik Modellemesi) Ön Koşuludur: Etki mekanizmalarını (aracılık/düzenleyicilik) test eden YEM analizine geçmeden önce, ölçüm araçlarının hatasız çalıştığını DFA ile kanıtlamak zorunludur.
DFA Kaça Ayrılır?
DFA, test edilen teorik yapının hiyerarşisine göre temel olarak ikiye ayrılır:
1. Birinci Düzey DFA (First-Order CFA): En yaygın kullanılan standart DFA türüdür. Gözlenen değişkenler (anket soruları) doğrudan kendi ait oldukları faktörlere bağlanır. Faktörlerin her biri de birbirleriyle çift yönlü oklarla (karyans/korelasyon) ilişkilendirilir. Örneğin; "İş Tatmini" ölçeğinin İçsel Tatmin ve Dışsal Tatmin olmak üzere iki boyutu varsa ve sorular doğrudan bu iki boyuta bağlıysa, bu birinci düzey bir modeldir.
2. İkinci Düzey DFA (Second-Order / Higher-Order CFA): Hiyerarşik bir şemsiye yapının test edilmesidir. Bazen alt faktörler kendi aralarında birleşerek daha üst/genel bir kavramı oluştururlar. Bu modelde anket soruları birinci düzey alt faktörlere bağlanır; bu alt faktörler ise (sorulara hiç temas etmeden) tepedeki tek bir "İkinci Düzey Şemsiye Faktöre" ok gönderir.
Örnek: Okuma, Yazma ve Matematik boyutları birinci düzey faktörlerdir. Bu üç faktörün birleşerek en tepedeki "Genel Akademik Başarı" faktörünü oluşturduğunu AMOS'ta çizip test ederseniz, bu İkinci Düzey DFA olur. 
Diyagramın mantığı:
· Oval (daire) → Gizil değişken (F1, F2) 
· Dikdörtgen → Gözlenen maddeler (X1, X2…) 
· Tek yönlü ok (→) → Faktör → madde (yükler) 
· Çift yönlü ok (↔) → Faktörler arası korelasyon 
· Küçük oklar (e1, e2…) → Hata terimleri

Örnek birinci düzey DFA:
[image: ]








Örnek ikinci düzey DFA:
[image: ]
AMOS’la DFA Uygulama Aşamaları
Aşama 1: Veri Aktarımı ve Modelin Çizilmesi
AMOS ekranı (Graphics alanı) boş bir tuvaldir. AFA'da keşfettiğimiz veya hazır bir ölçekten aldığımız teorik yapıyı buraya çizmemiz gerekir.
1. Veriyi AMOS'a Tanıtma: * Sol üstteki File -> Data Files menüsüne tıklayın.
File Name butonuna basarak SPSS (.sav) veri setinizi seçin ve OK diyerek kapatın.
2. Faktörleri (Gizil Değişkenleri) Çizme:
Sol araç çubuğundaki ağaç dalına benzeyen kırmızı-mavi ikona (Draw a latent variable or add an indicator...) tıklayın.
Boş ekrana bir kez tıklayarak büyük bir oval (Faktör) oluşturun. Ardından o faktörde kaç soru (madde) varsa, ovale o kadar tıklayın (Dikdörtgenler ve hata terimi yuvarlakları oluşacaktır).
Bu işlemi ölçekteki her bir alt boyut için tekrarlayın.
3. Soruları (Maddeleri) Modele Yerleştirme:
Sol menüdeki List variables in data set ikonuna tıklayın. SPSS'teki sorularınız liste halinde açılacaktır.
Soruları (Örn: S1, S2, S3...) sürükleyip doğru dikdörtgenlerin içine bırakın.
4. Hata Terimlerini İsimlendirme (Hayat Kurtaran Kısayol):
Küçük yuvarlaklara tek tek "e1, e2" yazmak yerine, üst menüden Plugins -> Name Unobserved Variables seçeneğine tıklayın. AMOS tüm boş hata terimlerini otomatik isimlendirecektir.
Büyük ovallerin içine çift tıklayıp (Object Properties -> Text) alt boyut isimlerini (Örn: Icsel_Motivasyon) boşluk bırakmadan yazın.
5. Kovaryansları (İlişkileri) Çizme: * Birinci Düzey DFA'da tüm faktörler birbiriyle ilişkili olmalıdır. Üst menüden Plugins -> Draw Covariances seçeneğine tıklayarak tüm büyük ovallerin arasına çift yönlü okların otomatik çizilmesini sağlayın.
Aşama 2: Analiz Ayarları
Modeli çalıştırmadan önce AMOS'tan bize hangi değerleri hesaplamasını istediğimizi seçmeliyiz.
1. Sol menüden Analysis Properties (renkli abaküs/piyano tuşu benzeri) ikonuna tıklayın.
2. Output sekmesine geçin ve şu iki kutucuğu kesinlikle işaretleyin:
Standardized estimates: Maddelerin faktör yüklerini (λ) görmek için.
Modification indices: Model uyumu kötü çıkarsa nerelere müdahale edeceğimizi görmek için.
3. Pencereyi çarpıdan kapatın.
Aşama 3: Modeli Çalıştırma ve Temel Çıktılar
1. Sol menüdeki Calculate Estimates (renkli abaküs) ikonuna basarak analizi çalıştırın. (Program dosyayı kaydetmenizi isteyecektir, kaydedin).
2. Hesaplama bitince sol menüdeki View Text (yazılı kağıt) ikonuna tıklayarak sonuç raporunu açın.
3. İlk bakacağınız yer: Estimates -> Scalars -> Standardized Regression Weights tablosudur.
Kritik Değer (Faktör Yükleri): Buradaki değerler faktör yükleridir. Maddelerin faktör yüklerinin .50'den büyük olması istenir (.30 veya .40'ın altında kalan maddeler modeli bozar ve modelden çıkarılması gerekebilir).
Aşama 4: Uyum İndeksleri (Model Fit) ve Kritik Değerler
DFA'nın kalbi burasıdır. Sol menüden Model Fit sekmesine tıklayın. Çıkan tablodaki karmaşık sayılar, çizdiğiniz modelin gerçek veriye ne kadar oturduğunu gösterir.
Kursiyerlerinizin mutlaka bilmesi ve makaleye yazması gereken Kritik Uyum İndeksleri ve 
Uyum Eşik Değerleri Tablosu:
	İndeks
	Açılımı
	İyi Uyum
	Kabul Edilebilir

	χ²/df
	Normed Chi-square
	≤ 3
	≤ 5

	GFI
	Goodness of Fit Index
	≥ .95
	≥ .90

	AGFI
	Adjusted GFI
	≥ .90
	≥ .85

	CFI
	Comparative Fit Index
	≥ .95
	≥ .90

	TLI (NNFI)
	Tucker-Lewis Index
	≥ .95
	≥ .90

	NFI
	Normed Fit Index
	≥ .95
	≥ .90

	IFI
	Incremental Fit Index
	≥ .95
	≥ .90

	RFI
	Relative Fit Index
	≥ .90
	≥ .85

	RMSEA
	Root Mean Square Error of Approximation
	≤ .05
	≤ .08

	SRMR
	Standardized Root Mean Square Residual
	≤ .05
	≤ .08


Aşama 5: Model İyileştirme (Modifikasyon)
Eğer Uyum İndeksleri tablosundaki değerler kabul edilebilir sınırların dışındaysa (Örneğin RMSEA .10 çıktıysa), modeli iyileştirmemiz gerekir.
1. View Text penceresinde sol taraftan Modification Indices (MI) sekmesine tıklayın.
2. Covariances (Hata terimleri arası ilişkiler) tablosuna bakın. M.I. sütunundaki sayılar, hangi iki hata terimini (Örn: e1 ile e2) birbirine bağlarsanız Ki-Kare (CMIN) değerinizin ne kadar düşeceğini (iyileşeceğini) gösterir.
3. En yüksek M.I. değerine sahip ikiliyi bulun.
4. Altın Kural: Modifikasyon SADECE aynı faktörün altındaki maddelerin hata terimleri arasında yapılır. Farklı faktörlerin maddeleri arasında modifikasyon yapmak teorik olarak hatadır (sorular binişik anlamına gelir).
5. AMOS çizim ekranına dönün, sol menüden çift yönlü ok (Draw covariances) ikonunu alıp, tespit ettiğiniz iki hata terimi yuvarlağı arasına ok çizin.
6. Calculate Estimates diyerek analizi yeniden çalıştırın. Uyum indekslerinizin iyileştiğini göreceksiniz. Gerekiyorsa bu işlemi (her seferinde tek bir çift yönlü ok çizerek) indeksler kabul edilebilir seviyeye gelene kadar tekrarlayın.
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Davis Teknigi Formiili
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KGI (Kapsam Gegerlik indeksi) =

Burada:
« m;: "Uygun” (a) diyen uzman sayisi
« mg: "Biraz Uygun” (b) diyen uzman sayisi

« N:Goris alinan toplam uzman sayisi
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« N.:Bir maddeye "Gerekli" yanitini veren uzman sayisi. (Dikkat: Diger iki segenegi
isaretleyenler hesaba katilmaz).

« N:Degerlendirme yapan toplam uzman sayisi.
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Kapsam gegerlilik oranmnimn hesaplanmas i¢in gerekli olan asagidaki gibidir (Lawshe. 1975):

v KGo=2% _
N/2

v NG= Maddeye uygun diyen uzman sayist

v N=Maddeye iligkin goris belirten toplam uzman sayist
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+ Madde 1: "Yéneticinin kurumun dijital daniisiim vizyonunu personelle paylagmast.”
« Uzman Dénisleri: 9 uzman *Gerekii®, 1 uzman “Gerekii degil” dedi.

+ Hesap:N. =9, N = 10.

. KGO =

« Sonug: Madde in KGO'su 0.80 gikt.

* Madde 2: "Yoneti

in en son gikan bilgisayar oyunlarini takip etmesi.
« Uzman Dénisler: Sadece 2 uzman “Gereki* ded. (Kalan 81 diger giklan isaretled).
+ Hesap: N, =2, N = 10.

. KGO =

« Sonug: Madde 2'nin KGO'su -0.60 gikt.




